April 9, 2013

Subject

Effective Date
Reference

Purpose

Background

Existing
Regulation

e reso e FOQram Guide Letter #582

Changes to CalFresh Expedited Services

Upon receipt.

All County Letter 12-74

e To inform staff of the change in policy allowing the maximum
certification period, (in accordance with the household’s
circumstances) for Change Reporting Households approved for
CalFresh through Expedited Services (ES) with postponed
verifications; and

e Clarify and reinforce current County policy for screening ALL
CalFresh applications to determine if applicants meet the
criteria for Expedited Services.

As a result of recently enacted state legislation, Assembly Bill (AB)
1359, two policy changes regarding CalFresh Expedited Service are
required to be implemented:

¢ |dentifying households that are entitled to ES, and

e Simplifying the existing policy regarding receipt of CalFresh
benefits under ES when verifications are postponed.

Current regulations require the review of the application form to
determine if the applicant completed the expedited service section in
order to process ES.

Previously, Change Reporting Households who were issued Expedited
Services with pending verifications were certified for:

e One month for households who applied before the 15" of the



month, or
e Two months for households who applied after the 15" of the
month.

Clarification

and Changes Effective January 1, 2013, ALL CalFresh applications must be

screened for Expedited Services (ES) even if the customer did not
attempt to answer the identifiable questions for Expedited Services
entitlement either on the DFA 285-Al, SAWS 1, or online application
forms. The County is reinforcing this policy which was previously
implemented in San Diego.

Additionally, all households issued CalFresh benefits under Expedited
Services will now be certified for the maximum certification allowable,
in accordance with the household’s circumstances. This means that
Change Reporting Households will no longer be certified for one or
two months based on the application date.

Updates to the CalFresh Program Guide are noted with highlighted
Text

Section Section Title Update

63-103.8 Right to File e Changed incomplete application
to partially completed application.

63-103.11 | Standardized e Changed not requesting to “not
Intake Process entitled.”

e Added “Document in Case
Comments.”

e Added CalWIN denial of CFES as
denial is inappropriate for
Expedited Services

63-105.2 Identifying or e Clarified that screening of
screening Expedited Services shall be
households completed regardless of whether
the identifiable questions were
answered on the application.

e Added that FRC will document in
Case Comments that the
application was screened.



http://hhsa-pg.sdcounty.ca.gov/FoodStamps/63-100/63-103_Filing_An_Application/63-103_Filing_An_Application.htm#_63-103.8�
http://hhsa-pg.sdcounty.ca.gov/FoodStamps/63-100/63-103_Filing_An_Application/63-103_Filing_An_Application.htm#_63-103.11�
http://hhsa-pg.sdcounty.ca.gov/FoodStamps/63-100/63-105_Expedited_Services/63-105_Expedited_Services.htm#_63-105.2�

63-105.4

Out of Office
Application

Included information regarding
handling of partially completed
applications.

63-105.7

Expedited
Services
Certification
Periods

Replaced one and two month
certifications with “all households
will be certified for the maximum
certification allowable.”

63-105.8

Households
with Postponed
Verifications

Changed section title from
“Change Reporting Households
with Postponed Verifications” to
“Households with Postponed
Verifications”

Changed one month certification
for Change Reporting
Households to procedures for
applications submitted on or
before the 15™ of the month.

Changed two month certification
for Change Reporting
Households to procedures for
applications submitted after the
15" of the month.

63-105.9

Verifications

Changed section title from
“Quarterly Reporting Households
with Verifications” to
“Verifications.”

Added information regarding
Identity as only required
verification for ES issuance.

63-301.5

Guideline
Table for
Establishing
Certification

Removed “household’s
application date is on or before
the 15™ calendar day of the
month and the case is granted
with pending verifications in order
to meet ES timeframe,” from 1
month certification.

Removed statement,
“household’s application date is
after the 15" calendar day of the
month and the case is granted
with pending verifications in order



http://hhsa-pg.sdcounty.ca.gov/FoodStamps/63-100/63-105_Expedited_Services/63-105_Expedited_Services.htm#_63-105.4�
http://hhsa-pg.sdcounty.ca.gov/FoodStamps/63-100/63-105_Expedited_Services/63-105_Expedited_Services.htm#_63-105.7�
http://hhsa-pg.sdcounty.ca.gov/FoodStamps/63-100/63-105_Expedited_Services/63-105_Expedited_Services.htm#_63-105.8�
http://hhsa-pg.sdcounty.ca.gov/FoodStamps/63-100/63-105_Expedited_Services/63-105_Expedited_Services.htm#_63-105.9�
http://hhsa-pg.sdcounty.ca.gov/FoodStamps/63-300/63-301_Certification_Periods/63-301_Certification_Periods.htm#_63-301.5�

Reminder

Operational
Impact

Automation
Impact

Forms (Client
Corresponden
ce)

Other
Programs
Impact

to meet ES timeframe,” from 2
month certification.

e Added “less than 12 months” to
certification table and added an

example.
63-304.5 Timely e Removed “Exception,” for CR
Application for Households

Recertification

Processing of the CalFresh application must conform to the notice,
procedural and timeliness requirement of the CalFresh regulations,
including processing Expedited Services.

Verifications obtained for other aid programs may also be used for
CalFresh, including Identification. However, processing the
CalFresh application will not be delayed, including Expedited Services,
due to lack of verifications which are needed for the other aid, but not
CalFresh (CEPG 63-119.3).

Staff will document in Case Comments that an evaluation for
Expedited Services was made on every CalFresh application and the
outcome of the determination (e.g. not eligible to ES, eligible and
approved for ES, etc.).

Change request CR6347-Granting Max Certification Periods for ES CF
HHs with Pending Verifications is pending with the CalWIN project and
is anticipated for a future release. Attachment A was developed as a
temporary workaround in the absence of a BEnDS. CalFresh Program
& Automation will alert staff when a new solution is developed.

Please see Attachment A for details on the approval Notice of Action
(NOA).

No impact.



http://hhsa-pg.sdcounty.ca.gov/FoodStamps/63-300/63-304_Recertification/63-304_Recertification.htm#_63-304.5�
http://hhsa-pg.sdcounty.ca.gov/FoodStamps/63-100/63-119_Application_with_Other_Aids/63-119_Application_with_Other_Aids.htm#_63-119.3�

ACCESS
Impact

Quality
Control
Impact

Approval

No impact.

Effective with the May 2013 sample month, Quality Control will cite the
appropriate error when the requirements in this material have not been
followed.

ﬂ«ﬂdﬂjwl M (lwlw Hows- 13

Rick Wanne, MA, MFT
Eligibility Operations Director




CFPG Letter #582 Attachment A. Temporary Workaround for
Change Reporting (CR) Households (HH) Certified Expedited
Services with Postponed Verifications.

Change reporting Households certified through Expedited Services with
postponed verifications are required to receive the maximum certification for
their household’s circumstances. CalWIN is currently not designed for this and
a Change Request has been submitted to the project. In the interim, the
following temporary workaround has been designed to avoid the possibility of
Quality Control errors.

If you have any questions regarding this workaround, please contact CalFresh
Program and/or CalFresh Automation. Eligibility Operations would like to thank
Stephanie Gunning, Eligibility Trainer for her additional assistance.

Run EDBC, review Wrap Up and ensure benefits are correct.

Welcome: Matt Hefferna

Laborate, Advance, Lead.  Win.

o, My Fa

pvigation Display Employment History Summary : Display Eligibility Summary

&) View History | | [E] Case Comments | § Run EDBC |

Save| Switch| Reset| Add| Detail| Delete| Print| Close

! Case #: 1BOKC94 Case Mame: Expedia, Eddie

View » Format - Freeze i Defach
Eligibility Benefit AU/ Householq Eligibility | Currently | Previously | Authorization
Program Type | PayMnt| Status Amt./SOC Size Begin Date | Overriden | Overriden Status
Expedited Food 503/2013 Pass $135.00 1 03/11/2013 N M Pending
Food Stamps 03/2013 Pass $0.00 1 03/11/2013 N M Pending
Food Stamps 04/2013 Pending £0.00 1 03/11/2013 N M Pending




Authorize Expedited Services.
Sy, My Favorites | [1"]

Display Shelter/Food Expense Summary s Display Eligibility Summary Authorize Eligibility Program Benefit

View History | %y View Deleted

Case Comments | % Run EDBC | QR Details

Save| Switch| Reset| Add Detail| Delete| Print| Close

Number:  1BOKC94 MName:  Expedia, Eddie Alerts... | Programs

Status: Pending Status Date: 03/11/2013 Pending Alerts: 2 Archived?| QR Cycle
View v Format ~ Freeze % Detach
Payment Payment Gross Benefit Recoupment Eligibility | Authorization| Select to
Program Month Type /soC Amt. | /Adjusted SOC Am{ Status Status Authorize | Benefit Bagin Dat
Expedited Fo 03/2013  Initial Benefit $135.00 Pass Pending 03/11/2013
Food Stamps 03/2013  Zero Benefit $0.00 Pass Pending [l 03/11/2013
Food Stamps 04/2013  Zero Benefit $0.00 Pending Pending -l 04/01/2013
* Issuance Type: EBT * Issuance Method: | Transfer Online |Z|
Pick-up Location: E| Supervisor Approval Requested [Y/N]: [ng E|
Disposition Status: Approved Disposition Date:
{  PavesNamels) | Expeds, Eddie | 38 | 654-32-2468[+] [=] [=]
Aid Paid Indicator: Mo Malto————— Amount

g) First Payee Address Gross Benefit / Medical 50C: £135.00
) Second Payee Address | pacoupment / Adjusted 50C:
' MNet Benefit / Net SOC: $135.00

Superyisor Action...| Authorize| Claim...| Select All| Deselect Al

| Discontinuance Date: |

Once Authorized, go forward in the queue. If Transaction Sampling is on, the
Supervisor must continue through the queue and follow these instructions.

Sy My Favorites | [|7) Reports | 258 Referrak

Display Eligibility Summary 3 Authorize Eligibility Program Benefit »

Jump:

View History

| % View Deleted | [Z§ Case Comments | % Run EDBC | QR Details

Save| Switch| Reset| Add| Detail| Delete| Print| Close

Number: 1BOKC94 Mame:  Expedi, Eddie Alerts... | Programs
Status:  Open Status Date: 03/14/2013 Pending Alerts: 3 Archived? QR Cycle
View v Format ~ Freeze % Detach
Payment Payment Gross Benefit ‘ Recoupment Eligibility | Authorization| Select to
Program Month Type /SoC amt. | /Adjusted SOC Am{  Status Status Authorize | Benefit Begin Date | Benefit End Date
Expedited Fo 03/2013  Initial Benefit £135.00 Pass Authorized (=] 03/11/2013 03/31/2013
Food Stamps 03/2013  Zero Benefit £0.00 Pass Pending al 03/11/2013 03/31/2013
Food Stamps 04/2013  Zero Benefit £0.00 Pending Pending |l 04/01/2013
3 Dispk
* Issuance Type: EBT * Issuance Method: | Transfer Onine =]
Pick-up Location: E| Supervisor Approval Requested [Y/N]: [yg E|
Disposition Status: Approved Disposition Date:
j Payee Name(s): |Eypedia, Eddie | 38 | 654-32-2468 =] =] =]
Aid Paid Indicator: No (Mailto——————————— A t
| Discontinuance Date: | | @ First Payee Address Gross Benefit | Medical 50C: $135.00

() Second Payee Address | pacqupment / Adjusted SOC:
- Met Benefit / Met SOC: $135.00

i Supervisor Action...| Authorize| Claim...| Select All| Deselect All Select Provider..,




Add a record for Case Comments and document the determination of
Expedited Services.

Sy My Favorites | ;") Reports | 353 Referraks | a= External Data| g

Display Shelter/Food Expense Summary s Display Eligibility Summary Search Case Comments x
Jump:
v History | ¥ View Deleted | a mments | Run EDAC | QR Details
Save| Switch| Reset| Add| Detai| Delete| Print| Close " Re
= Case #: 1BOKC34 First Name:
i Type: |z| Last Name:

Text: Program: E
Date Range

From: [y To: £ Sensitive[Y/N]: [+] isearch

View ~ Format + Freere 5! Detach
Type ‘ Date | Program | User | Individual System Comments User Comments

Single 38-y-old homeless male. HH of one. St:
under the bridge downtown. Clt states that |
as 3 day laborer three hours per week and is |
HH is conferred MCE. CR HH QR377.5 explaine

Faod Stamps 03/14/2013 02:36 PM Heffarnan, Matt iﬁgiggég ﬁ?ﬁ;ﬁ?{gﬁ;i”é‘éﬂf?:ﬂ”dtisn'g“i;
wverification from Day Laborers. ES Eligible and
today. Explained the need to provide the incc

ﬂ or letter from employer by 4/10/13 to contini
benefits. Issued EBT Card.

System Generated  03/14/2013 02:00 PM Expedited Food Stamps Heffernan, Matt This case is APPROVED.
System Generated  03/13/2013 01:08 PM Food Stamps Heffarnan, Matt This case is Assigned to caseload 2 V122 .
System Generated  03/13/2013 01:08 PM Expedited Food Stamps Heffernan, Matt This case is Assigned to caseload # VI22 .

< m 1

4 Displayed Rows. Mo More Rows.

Highlight Expedited Services Approval Notice (QR 377.1) and check the
Details button

S My Favorites | () Reports | g3 Referrals | s Extemal Dafa| Q Query -

Display Eligibility Summary 3 Search/View for Client Correspondence in Print Queua »

Jump: Go
ts| § Run EDBC | [Q] QR Detais
Save Switch| Reset| Add| Defai| Delete| Print| Close| * Requied
Search Criteria
Correspondence Type: E Prograr:
Correction NOA [Y/N]: Action:
NOA/Form #: MNOA/Form Name:
Reference Type: E Reference #:
Case 71 1ROKCO4 Print Mode:
Caseload #:
Case Name
Last: First:
LI Suffoc:
Search Results

View ~ Format » Freeze B Defach

j Manual Variables
Case # | Program | Action| Reason Description |Reference Type|Reference ID| Requested Datq Process Date [¥/N] Correspond, Correspond, Name| Case Langu
1BOKC94  Expedited Fooc additional information/ .. 2013-03-14 20130314 N CSF78(04/04)  Verification Checklst - ... Englsh
1BOKC94  Food Stamps Shelter cost verficatio... 2013-03-14 20130314 Y CSF 47 Housing Statement/ V... English
1BOKC94  Expedited Fooc Approval The indwidual's EX foo... 2013-03-14 20130314 N QR 377.1 (04/04) Food Stamp Notice of ... English
< . | ’

3 Displayed Rows. No More Rows. More

State Version| Print| Deta...




Review to ensure that it is the ES approval notice with “delayed verifications.”
Once completed, select Delete Correspondence. The Notice generated by
CalWIN will have the wrong certification dates.

Display Eligibility Summary 3 Search/v

View History | View Deleted | [& Case Comments | Run EDBC | QR Details

Save| Switch| Reset| Add| Detail| Delete| Print| Close

Client Correspondence Detail

Type: Motice Of Action Program: Expedited Food Stamps
Corrected MDA [Y/N]: [ ng E| Action: Approval
Case Languzge: English Print Language: English
Print Mode: | patch [+]| State Translated [Y/N]: Yes State Version
Manual Variables [Y/M]: Mo Requested Date: 03/14/2013
View ~ Format - Freeze A Detach
Correspondence # Correspondence Name |

QR 377.1 (04/04) Food Stamp Motice of Approval

View ~ Format = Freeze i Detach
HOA Reason Description
jThe individual's EX food stamps approved and there are delayed verifications that are due b...

Delete Correspnndence| MNOA Variables...| Enter Form/Tandem Variables...




Move forward in the queue to the RRR Detail Listing. Select the Edit RRR
button.

.-', ip Naidgation

f
Ay
-tfwiﬁ-— calwinN. cpllaberate, Advance, Lead. . Wik

Welcome: Stephanie Gunning 1

Mol tvigaton | My Links ~ S MeEnis
Worker Home » Main Ravigation « Display Applcation Summary x Perform Data Collection Wrap-up | Display Ebgibility Summary View RAR Detal

View RRR Detail Listing

|
) Ve sty | % Vi Deleted | 51 Case Comment | §
Sava| Switch M Add Dolnl| Delote EM
Search Criteria
Dffice; tUnit: Usar” P
® Cag #: 160KD28  Program: Status:
* Begin Month; * End Month:
Search Results
View = Format = Freeze [ Detach
RRR RRR Appt. | Appt. Malln | Checklist| Packet | Resemd
| Userflame | Case# Case llame Program Month | Status Date Tme |ApptStatus| DueDate = Exists | Receved | Packet
']Guglltgg.,__‘il.!mm 180KD28 Te&:.T_ddd Food Starmps 020014 Panding Ha

Rows Selected 1

Checkist.| Schadukt RRR Agpositn

Enter the correct RRR month (12 months, 24 months, etc.) then save and
close.

Perdorm Bata Collk

ey FRR Datai | reting >

Edit RRR Details
oy | M View Deleted | [l S2ss Comments |
spve| Switch Reset| Add| Detalll Detets! print| Ciose

Original RRR Manth: 02/2014
® Mew RRR Month: | g2/2014

Mad-1n Due Date: 8
Resend Facket [¥/M]: E]
Packet Recered Date:
Packet Racehved Complets [Y/H]: E
Appointment Reguired [Y/N]: |yes 3
Mathod Recesed: E[



The new RRR month should display. Save and close.

NOTE: YOU MUST DO THIS WHEN ES IS FIRST AUTHORIZED. Once you
leave the queue you will not be able to alter the RRR unless the RRR
queue/workflow is initiated.

Generating the Notice

Once you have changed the recertification date, you must manually generate
the correct Notice of Action (NOA). To do this you must go to the Print a NOA
Manually window under Client Correspondence and select Search.

Main Navigation | My Links -

Main Navigation «

i

® Alerts & Broadcast Messages Search for an Action by typing the first few letters

® Appointments

® Authorizations Review

® Benefit Issuance and Recovery & Autharization i

® Case Assignment © (Client Correspondence i

® Clearance . - ® Creste Freeform MNOA

: E;naprli%;nent Selcm s il ® Print 3 Form/Other Correspondence manuzly

S e ® Print 2 NOA Manualy |
® Search for Printed Correspondence 3

wllliterta Achvhes ® Search/View for Client Correspondence in Print

® Program/Provider Maintenance & Data Collection

® QC/QA Activities & Eligibility Determination

® Registration 5 Error Prone T

® FRRR & General System

® Security & Hicknns Maintananra i

® Simulation

® System Maintenance

® Wrap Up

® View All

Add Open Search



Search for the Food Stamp approval and select the Find button.

Main Navigation | My Links = G My F
Worker Home 3 Search NOA «
~| Related Links
No data to display. View History | X View Deleted | [ Case Comments | § Run EDBC | [Q] QR Detais

Save Switch| Reset| Add| Detall Delete Print| Close

Search Criteria

* Action: | Appraval [+] Program: | Food Stamps [=]
Reason Code: Reason Description: Find...
NOA/Form #: NOA/Form Name: m
Search Results

View » Format - Freeze & Detach
Effective Begin Date| Action | Reason Code|NOA/Form{  NOA/Form Name  Template Namy Back Template Nai

No data to disply

NOA Header NOA Text

Search for NOA/Form # QR 377.1 and enter Select

srd Company [US]| hitps://calwinapp.folsom.calwin.eds.com:7072/cwetrn/faces/org/calwin/uimanager/pages/DynamicTabbedNavigation jspx?_adf.ctrl-state=sbhux3ig_3& i ¢ =

¢ 1§

Welcome: Matt Heffarnan My Settings+ Web Links v View Mode + 0 Help + :-: Logout

abgrate, Advance, Lead. Win.

4y, My Favorites | (") Reports | 28 Referrals | = External Dafa| Q Query ~

TETSEN  Search HOA «

Jump: Go >

View History | % Vie ted

d | [ Case Comments | § Run EDBC | QR Details
Save| Switch| Reset| Add| Detail Delete| Print| Closs| * Requred
Search Criteria
= Correspondence Type: Notice Of Action
Correspondence #: [qr 377.1
Correspondence Name:

Search
Search Results
View v Format » Freeze g Defach
Correspondence 4 Correspondence Name |

QR 377.1 (04/04) Food Stamp Notice of Approval

1 Displayed Rows. No More Rows. More

Select]




Select the Reason Code FAF315 and click the Select button.

Sy, My Favorites | [{") Reports |

Switch

Search Criteria
* Action:

Reason Code:

Save

Approval

NOA/Form

Search Results

Search NOA «

Reset| Add| Detail

[=]

Delet

Print | Close

Program:

Reason Description:

#: QR 377.1 (04/04)

Food Stamps

MNOA/Form Mame: Food Stamp Notice of Approval

View ~ Format ~
Effective Begin Date| Action | Reason Code| NOA/Form 4 NOA/Form Name Template Nam4 Back Template Nam|Budg Nam+ Documen
04/07/2006 Approval FAF309 QR 377.1 ... Food Stamp Motice of Appr.. MOA Default .. NA Back 9@ Standard I
04/07/2006 Approval FAF311 QR 377.1 ... Food Stamp Motice of Appr.. MNOA Default .. NA Back @ Standard I
04/07/2006 Approval FAF317 QR 377.1 ... Food Stamp Motice of Appr... NOA Default .. NA Back 9 Standard 1
04/07/2006 Approval FAF314 QR 377.1 ... Food Stamp Motice of Appr.. MNOA Default .. NA Back 9 Standard I
04/07/2006 Approval FAF316 QR 377.1 Food Stamp Motice of Appr_. MNOA Default NA Back 9 Standard I+
10/26/2006 Approval FAF320 QR 377.1 ... Food Stamp Motice of Appr.. MNOA Default .. NA Back 9 Standard I
10/26/2006 Approval FAF321 QR 377.1 ... Food Stamp Motice of Appr.. NOA Default .. NA Back @ Standard I
b 01/01/1990 Approval FAF313 QR 377.1 ... Food Stamp Motice of Appr.. NOA Default .. NA Back 9 Standard b
01/01/1950 Approval FAF315 QR 377.1 ... Food Stamp Motice of Appr.. MOA Default .. NA Back 9 Standard I+
01/01/1990 Approval FAF308 QR 377.1 ... Food Stamp Motice of Appr.. NOA Default .. NA Back 9 Standard I
Rows Selected 1
NOA Header NOA Text

Your application for Food Stamps

has been approved. Your

certification covers the period 1]

through |2].

]

another notice. If the verification =
wou send changes your eligibility or =
benefits, we wil make the change.
You will not get an advance notice

before we take this action. &

Select the NOA Variables button.

&, My Favorites | [{") Reports | 353 Referals | w= E

Print a NOA Manually »

Switch | Reset| Add| Detail Delete Print| Close

Jump:

wvigation s
v | ¥ View Deleted |
Save
NOA Details
*(ase #: |1BOKCo4

* Print Mode: | Immediate [+]

View ~ Format =

Effective Begin Date| Action | Reason Code |NOA/Form §

* Program: | Food Stamps

|Z| * Individuzl MName:

Foster Care Provider: 0
Budget Month/Year:

NOA/Form Name

Expedia, Eddie | 38 | 654-32-2468E|

|Te|||plate Nam4 Back Template Nam| Budget Namy Document Header

01/01/1950 Approval FAF315
NOA Header
Your application for Food Stamps  «
has been approved. Your El
certification covers the period |1] —

through |2|.we used the facts you

gave us to figure your benefits. If

QR377.1 .

j MNOA Variables...| Tandem Correspondence Variables...| Freefom Text...

Food Stamp Motice of Approval NOA Default

A Back 9 Standard NOA

NOA Text

Because you need
right away, we did
give us the followir
verification:|1] You
verification before




Change the Certification end date/Redetermination due date to the month the
recertification is due. Enter the Grant amount, Pay month and HH size in SFU.
Once variables are entered, save and close.

ew History | ew Deleted | Case Comments | lun EDBC |
Save | Switch| Reset| Add| Detail Delete| Print| Close

Document Header Variables Header Variables Body Text Variables Footer Variables Budget Line Va

Enter Variable Value

View - Format ~ Freeze f Detach
Eligibility - AG effective start/change date: 3/11/2013
Certification end date / Redetermination due date:  2/28/2014
Grant Amt - list: 135.00
Pay Mnth - list: 03/2013
SFU Size - list: 1

Variable Description

Select Preview to confirm the NOA is correct.
NOTICE OF ACTION COUNTY OF SAN DIEGO HEALTH AND HuMiLAJE[

CALIFORNIA DEPARTMENT OF S
Food Stamps Approval

Notice Date : 03/19/2013

Case Name : Eddie Expedia

Case Number : 1BOKC94

Worker Name : M. Heffernan

Worker Number : VI22

Telephone :

Worker Hours : 8:00 AM-12:00 PM, 1:00 PM-
24Hour Information

Address : 5201 Ruffin RD, STE K

San Diego CA 92123-4394

Eddie Expedia

PO BOX 301992

Escondido CA 92030-1992 State Hearing: If you think this action is wrong,
for a hearing. The back of this page tells you hc

benefits may not be changed if you ask for a hei
A A A A A A L this action takes place.

Questions? Ask your Worker.

Your application for Food Stamps has been approved.
Your certification covers the period 3/11/2013
through 2/28/2014.

We used the facts you gave us to figure your benefits.
If nothing changes, you will get:

Grant Amount Month Number of Person(s)
135.00 0372013 1

Because you needed Food Stamps right away, we did not
require you to give us the following verification:

Billing information verification

Income received verification - Eddie Expedia




Set the Print Mode to Immediate or Batch and select Print when the NOA is
ready to generate.

Sy, My Favorites

(1) Reports | g7g Referrks | = Extemal Date| Q

vigation 3 Print a NOA Manually » Search on Case Information Search for Printed Correspondence i
Jump:
View History | ¥ View Deleted | its| § Run EDBC | ] R Detais
Save| Switch| Reset| Add Detal Delete M Close *F
NOA Details
*Case # 1aokcod  *ProwaEm: | Food Stamps [w|  *Individual Name: | Expecis, Eddie | 38 | 654-32-2468 [«
* Print Mode: | tmmediate [«] Foster Care Provider: 0

Budget: Month/ Year: E

View ~  Format ~ Fraeze

Effectve Begin Date| Action | Reason Code [NOA/Form{  NOA/Form ame | Template Nami Back Template Nam| Budget Nami Document Header
01/01/1990 Approval FAF315 QR377.1 ... Food Stamp Notice of Approval NOA Default .. NA Back 9 Standard NOA

1 Displayed
NOA Header

Your application for Food Stamps ~ » Bacause you needed Food Stamps
has been approved. Your El

right away, we did not require you f
certfication covers the period [1] —

qive us the following
through |2|.We used the facts you ™ verification:] 1| You must give us this
gave us to figure your benefits, IF verification before |2| or your Food

j NOA Variables...| Tandem Correspondence Variables...| Freefom Text... Reset| Print| Pre

NOA Text
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